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NO.1 How does Tableau know at which level to aggregate values?
A. Values are always aggregated at the level of granularity of the worksheet.
B. Tableau doesn't aggregate values, we do!
C. Values are always aggregated at the level of the Date Part
D. Aggregation is always done by using Tableau special formulas
Answer: A
Explanation:
In Tableau, you can aggregate measures or dimensions, though it is more common to aggregate
measures.
Whenever you add a measure to your view, an aggregation is applied to that measure by default. The
type of aggregation applied varies depending on the context of the view.
When you add a measure to the view, Tableau automatically aggregates its values. Sum, average, and
median are common aggregations; for a complete list, see List of Predefined Aggregations in Tableau.
The current aggregation appears as part of the measure's name in the view. For example, Sales
becomes SUM(Sales). Every measure has a default aggregation which is set by Tableau when you
connect to a data source. You can view or change the default aggregation for a measure-see Set the
Default Aggregation for a Measure.
You can change the aggregation for a measure in the view from its context menu:
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NO.2 You view the relationship canvas shown in the following exhibit.

 

What does Migrated Data indicate?
A. The workbook was created in previous version of Tableau Desktop.
B. The data was imported from Tableau Server.
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C. The data was recently saved as a packaged data source.
D. The workbook was downloaded from Tableau Online.
Answer: A
Explanation:
In the context of Tableau, "Migrated Data" typically refers to data or workbooks that have been
upgraded from a previous version of Tableau Desktop. When you open a workbook in a newer
version of Tableau, the data sources within that workbook might be labeled as "Migrated Data,"
indicating that they have undergone a conversion process to be compatible with the new version's
features and architecture.

NO.3 Which of the following are benefits of combining sheets using dashboards?
A. Easier to compare visualisations side by side
B. It is mandatory to combine sheets when using Tableau
C. Helps in faster analysis
D. Provides the ability to use one sheet as a filter for other
Answer: A C D
Explanation:
The only incorrect option is - It is mandatory to combine sheets when using Tableau.
All others are valid advantages that Dashboards provide when using Tableau!

NO.4 A dual axis chart is useful for comparing two measures that___________.
A. have different scales
B. have little in common
C. are Table Calculations
D. are aggregated Dimensions
Answer: A
Explanation:
A dual axis chart is useful for comparing two measures that have different scales. A dual axis chart is a
type of visualization that shows two measures using two independent axes layered on top of one
another. A dual axis chart allows you to compare and contrast two measures that have different
ranges or units of measurement, such as sales and profit margin, temperature and precipitation, or
population and GDP per capita. A dual axis chart can also show different mark types for each
measure, such as bars and lines, circles and areas, or shapes and texts. The other options are not
valid reasons for using a dual axis chart for comparing two measures. Have little in common is not
correct, because a dual axis chart is meant to show some kind of relationship or correlation between
two measures, not just contrast them. Are Table Calculations is not correct, because a dual axis chart
can be used with any type of measure, whether it is an aggregation, a calculation, or an expression.
Are aggregated Dimensions is not correct, because a dual axis chart cannot be used with dimensions,
only with measures. Dimensions are fields that contain qualitative values that are used to categorize
or segment data, not compare them.

NO.5 True or False: It is possible to add a field to more than one hierarchy
A. True
B. False
Answer: A
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Explanation:
Yes! It is possible to duplicate a field and add it to more than one hierarchy. Right click and choose
duplicate.

NO.6 You can _______________ your data to combine two or more tables by appending values
(rows) from one table to another
A. join
B. blend
C. concatenate
D. union
Answer: D
Explanation:
You can union your data to combine two or more tables by appending values (rows) from one table
to another.
To union your data in Tableau data source, the tables must come from the same connection.
For example, suppose you have the following customer purchase information stored in three tables,
separated by month. The table names are "May2016," "June2016," and "July2016."

A union of these tables creates the following single table that contains all rows from all tables.

IT Certification Guaranteed, The Easy Way!

5

Practical Desktop-Specialist Question Dumps is Very Convenient for You - Lead2Passed

Desktop-Specialist question Dumps,  Desktop-Specialist study tool,  Desktop-Specialist exam braindumps
https://examsdocs.lead2passed.com/Tableau/Desktop-Specialist-practice-exam-dumps.html

https://examsdocs.lead2passed.com/Tableau/Desktop-Specialist-practice-exam-dumps.html


NO.7 Which of the following is a benefit of using a Tableau Data Source (.tds)?
A. To hold one or more worksheets, plus zero or more dashboards and stories.
B. To not contain the actual data but rather the information necessary to connect to the actual data
as well as any modifications you've made on top of the actual data such as changing default
properties, creating calculated fields etc
C. To create a single zip file that contains a workbook along with any supporting local file data and
background images. This is great for sharing your work with others who don't have access to the
original data.
D. To create a local copy of a subset or entire data set that you can use to share data with others,
when you need to work offline, and improve performance.
Answer: B
Explanation:
The following are the official definitions from the Tableau documentation for the various file types:
1) .tds (Tableau Data Source) - To not contain the actual data but rather the information necessary to
connect to the actual data as well as any modifications you've made on top of the actual data such as
changing default properties, creating calculated fields etc. (CORRECT ANSWER)
2) .twbx ( Tableau packaged workbook) - To create a single zip file that contains a workbook along
with any supporting local file data and background images. This is great for sharing your work with
others who don't have access to the original data.
3) Extract (.hyper or .tde) - To create a local copy of a subset or entire data set that you can use to
share data with others, when you need to work offline, and improve performance.
3) (.twb) Workbooks - To hold one or more worksheets, plus zero or more dashboards and stories.

NO.8 If you see the following Filter, then you're working with _______________________ Larger
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A. Grouped Dates
B. Date Functions
C. Date Parts
D. Date Values
Answer: D
Explanation:
Dates in Tableau will behave differently depending on whether they are a Datepart (blue) or a
Datevalue (green). This affects how the axes display/behave and also how visualisations such as line
charts will display.
The difference essentially boils down to Dateparts behaving like a dimension as opposed to a
measure which is how Datevalues behave. This means that Dateparts behave like discrete categories
on the view whereas Datevalues are more like continuous numeric values.
Dateparts are discrete and they behave the same as dimension filters. If all dates are used on the
filter then each individual date will be a datepart that can be selected/excluded. This is the same for
each level of date, if datepart months is placed on filters January to December will be tick-able
options in the filter. This also means that conditions and top/bottom filters can be applied to
datepart filters like any other dimension filter.
Datevalues placed on filters behave like measure filters. A min and a max date can be set and there is
a relative dates option which allows you to choose things like only show the previous 3 months or
years etc.
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NO.9 You need to access options to change a dimension's color palette.
In addition to the Marks card, what else can you use?
A. The Color legend
B. Edit in Shelf
C. The Format menu
D. Edit Caption
Answer: A
Explanation:
You can use the Color legend to access options to change a dimension's color palette, in addition to
the Marks card. The Color legend shows the colors assigned to each member of the dimension in the
view. You can right-click on the Color legend and select Edit Colors to open the Edit Colors dialog box,
where you can change the color palette, assign specific colors to dimension members, or edit the
color transparency and border6 The other options are not valid ways to change a dimension's color
palette. Edit in Shelf is a feature that allows you to edit the fields on the Rows or Columns shelves by
typing directly on the shelf. It does not affect the color palette of the dimension7 The Format menu
allows you to change the appearance of various elements in the workbook, such as fonts, borders,
shading, alignment, etc. It does not have options for changing the color palette of the dimension8
Edit Caption is a feature that allows you to add or edit a caption for a worksheet or dashboard. It
does not affect the color palette of the dimension

NO.10 How can you create a packaged data source?
A. From the Worksheet menu, select Export, and then select Data.
B. From the Data pane, right-click the data connection, and then select Add to Saved Data Sources.
C. From the File menu, select Share.
D. From the File menu, select Save As.
Answer: B
Explanation:
To create a packaged data source (.tdsx file) in Tableau, you would right-click on the data connection
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in the Data pane and select the option to add it to saved data sources. This action packages the data
source with the metadata that you've defined in Tableau, such as calculations, groups, and sets, so
that you can easily share it with others. This does not package the data itself, which is a separate step
if you're working with local file-based data.

NO.11 Which two actions can you perform when you join tables from multiple connections? Choose
two.
A. Create a union.
B. Use a stored procedure.
C. Add a data source filter.
D. Create an extract.
Answer: C D
Explanation:
You can perform two actions when you join tables from multiple connections: add a data source filter
and create an extract. A data source filter is a filter that you can apply to the data source before it is
loaded into Tableau. This can help improve performance and reduce the amount of data in the view.
A data source filter can be applied to any data source, including those that use cross-database joins2
An extract is a snapshot of data that is stored locally on your computer or on Tableau Server. An
extract can also improve performance and enable offline analysis. You can create an extract from any
data source, including those that use cross-database joins3 You cannot perform the other two actions
when you join tables from multiple connections: create a union or use a stored procedure. A union is
a method for combining data by appending rows of one table onto another table. To union your data
in Tableau, the tables must come from the same connection. You cannot union tables from different
data sources or connections4 A stored procedure is a set of SQL statements that can be executed on
a database server. Tableau does not support using stored procedures as part of a cross-database join.
You can only use stored procedures with some single-connection relational data sources, such as
Microsoft SQL Server, Oracle, or PostgreSQL5

NO.12 How would you calculate GDP per capita in Tableau?
A. SUM([GDP]/[POPULATION])
B. SUM([Population]/[GDP]])
C. SUM([GDP]*[POPULATION])
D. SUM([GDP]) / SUM([Population])
Answer: D
Explanation:
GDP / Population = GDP Per Capita

Here Sum is a function, / and + are operators. On the bottom there are comments.

NO.13 You create the following visualization.
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What is the first step to create the visual grouping of the 10 marks shown in blue?
A. Select the desired 10 marks in the view.
B. Create a Group on the Property Description field in the Data pane.
C. Select the desired 10 text labels under Property Description.
D. Create a Set on the Neighborhood field in the Data pane.
Answer: A
Explanation:
To visually group marks in Tableau, you typically start by selecting the marks directly in the view.
Once the desired marks are selected, you can then create a group from them. This will visually group
the selected marks, as indicated by the blue color in the example provided.

NO.14 How can you format an axis as Bold in Tableau?
A. By choosing the axis and selecting Command/Control + B on your keyboard
B. By right clicking on the axis, choosing Edit Axis, and then setting its font to bold.
C. By right clicking on the axis, choosing format, and then setting its font to bold.
D. By clicking on Format on the main menu bar, choosing field labels, and setting it to bold.
Answer: C
Explanation:
To make an axis bold, simply right click it, select format, and then click on Font to choose Bold:
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None of the other options are valid ways to make the axis bold.
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Read more about editing axis: https://help.tableau.com/current/pro/desktop/en-
us/formatting_editaxes.htm

NO.15 Which type of chart can you create without using a dimension?
A. Stacked bar
B. Highlight table
C. Bar
D. Treemap
Answer: C
Explanation:
Bar charts in Tableau do not require a dimension to be created. You can create a bar chart using only
a measure; this will produce a single bar that represents the aggregate of the measure values, such as
the sum or average of sales.

NO.16 You can use the __________________ in Tableau to clean / organise your data.
A. Data cleaner
B. Data manager
C. Data interpreter
D. Data organiser
Answer: C
Explanation:
When you track data in Excel spreadsheets, you create them with the human interface in mind. To
make your spreadsheets easy to read, you might include things like titles, stacked headers, notes,
maybe empty rows and columns to add white space, and you probably have multiple tabs of data
too.
When you want to analyze this data in Tableau, these aesthetically pleasing attributes make it very
difficult for Tableau to interpret your data. That's where Data Interpreter can help.
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NO.17 If you decide you want to see all of the marks in the view at the most detailed level of
granularity, you can
__________________ the view.
A. sort the measures
B. disaggregate the measures
C. break-down the measures
D. aggregate the measures
E. split the measures
Answer: B
Explanation:
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The different aggregations available for a measure determine how the individual values are collected:
they can be added (SUM), averaged (AVG), or set to the maximum (MAX) or minimum (MIN) value
from the individual row values.
For a complete list of the available aggregations, check out - List of Predefined Aggregations in
Tableau.
The level of detail is determined by the dimensions in your view-for information about the concept of
level of detail, see How dimensions affect the level of detail in the view.
Disaggregating your data can be useful for analyzing measures that you may want to use both
independently and dependently in the view. For example, you may be analyzing the results from a
product satisfaction survey with the Age of participants along one axis. You can aggregate the Age
field to determine the average age of participants or disaggregate the data to determine at what age
participants were most satisfied with the product.
Disaggregating data can be useful when you are viewing data as a scatter plot. See Example: Scatter
Plots, Aggregation, and Granularity.

NO.18 Which type of date filter can you use to choose a range of dates based on TODAY ()?
A. Range of dates
B. Relative dates
C. Ending date
D. Starting date
Answer: B
Explanation:
The relative date filter can be used to select a range of dates relative to the current date, such as the
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past month, the current quarter, etc. This filter type dynamically adjusts the range based on the
current system date, making it suitable for use with the TODAY() function.

NO.19 Which of the following are interactive elements that can be added to a dashboard for users?
A. URL Action
B. Filter Action
C. Highlight Action
D. Edit Tooltip Action
Answer: A B C
Explanation:
We can perform filter, URL and highlight actions out of the above given choices on a dashboard.
Please refer to the image below:
Graphical user interface Description automatically generated

NO.20 Which of the following are required to create a trend line?
A. 2 measures on opposing axes, or a date and a measure on
opposing axes.
B. 1 measure, or a date and a dimension on opposing axes.
C. 1 measure only
D. 2 dimensions, or a date and a dimension on opposing axes.
Answer: A
Explanation:
To create a trend line, we need:
Graphical user interface, application Description automatically generated
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NO.21 Download the Dataset from:
https://drive.google.com/file/d/12AYHfiPWkwBmvH0zbumOURgUX6Az00Rw/view?usp=sharing
Using the Time Series Table, create a line chart to show Sales over time. Which Month and Year
witnessed the lowest Sales?
A. September 2017
B. March 2018
C. December 2017
D. January 2018
Answer: D
Explanation:
Follow the steps to get the correct answer : January 2018
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We are talking about dates, so use the Time series sheet as follows:
Next, the following should be your view and clearly, January 2018 is the lowest point:

Read more about dates:
https://interworks.com/blog/rcurtis/2017/01/30/tableau-deep-dive-dates-introduction-dates/

NO.22 DOWNLOAD THE DATASET FROM -
https://drive.google.com/file/d/1F8L_Rl5B9LAz8RDi-DdjWx3Iv-SgzaBq/view?usp=sharing ( if you
haven't already from the test instructions page! ) How many different countries are present in the
dataset?
A. 150
B. 147
C. 140
D. 156
Answer: B
Explanation:
To reach the correct answer, follow these steps:
1) You can simply drag Country to the view, and look at the marks in the bottom left of Tableau
Desktop - 147 marks!
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2) Or, you can simply go to Data Source -> Country Tab -> Describe

As you can see, 147 members exist in this Country column!

NO.23 What is a story point in Tableau?
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A. A single worksheet or dashboard
B. A collection of dashboards
C. A collection of both worksheets and dashboards
D. A collection of worksheets
Answer: A
Explanation:
In Tableau, a story is a sequence of visualizations that work together to convey information. You can
create stories to tell a data narrative, provide context, demonstrate how decisions relate to
outcomes, or to simply make a compelling case.
A story is a sheet, so the methods you use to create, name, and manage worksheets and dashboards
also apply to stories (for more details, see Workbooks and Sheets). At the same time, a story is also a
collection of sheets, arranged in a sequence. Each individual sheet (worksheet or dashboard) in a
story is called a story point.
When you share a story -for example, by publishing a workbook to Tableau Public, Tableau Server, or
Tableau Online-users can interact with the story to reveal new findings or ask new questions of the
data.

NO.24 In an extract, what are three differences between a full refresh versus an incremental
refresh? Choose three.
A. An incremental refresh only adds rows that are new
B. A full refresh must be configured. An incremental refresh is the default extract in Tableau.
C. An incremental refresh can only be run from Tableau Server.
D. A full refresh is usually very slow. An incremental refresh can take less time.
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E. A full refresh replaces all the extracted data with the data in the underlying data source.
Answer: A D E
Explanation:
According to the [Tableau Desktop Specialist Exam Guide], an incremental refresh only adds rows
that are new, based on a specified column and value. A full refresh replaces all the extracted data
with the data in the underlying data source. A full refresh is usually very slow, especially for large
extracts. An incremental refresh can take less time, depending on how many new rows are added. A
full refresh does not need to be configured, it is the default option for extracts in Tableau. An
incremental refresh can be run from both Tableau Desktop and Tableau Server.

NO.25 What are two benefits of using a live connection to a data source as compared to an extract?
Choose two.
A. Alive connection to a database server requires less network overhead than an extract.
B. A workbook connected to a live connection will have fresher data than a workbook connected to
an extract.
C. A live connection reduces the amount of memory used on a client computer as compared to an
extract.
D. A live connection is always faster than an extract.
Answer: B C
Explanation:
The benefits of using a live connection over an extract include:
B: A live connection ensures that the data in the workbook is as up-to-date as the database itself,
providing fresher data compared to a static extract which is updated at intervals.
C: A live connection queries the database server directly, which means it uses the server's memory
and processing power rather than relying on the client computer's resources.
A live connection does not necessarily require less network overhead (A) as it may continually send
queries over the network, and it is not always faster than an extract (D) because extracts can provide
quicker response times for complex queries or large datasets.

NO.26 What are two requirements to combine two tables by using a union? Choose two.
A. Related fields must have matching data types.
B. Related fields must have different names.
C. The tables must come from different connections.
D. The tables must have the same number of fields.
Answer: A D
Explanation:
To perform a union in Tableau, the tables must have a related field with matching data types, and
they must have the same number of fields. This allows the tables to be appended vertically in the
data source. Different names or tables from different connections do not affect the ability to union
the tables.

NO.27 You have the following visualization.
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You need to show how Internet Usage values change from year-to-year as a percentage. Which quick
table calculation should you apply to the Internet Usage field?
A. Compound growth rate
B. Percent difference
C. Difference
D. Percentile
Answer: B
Explanation:
To show how Internet Usage values change from year to year as a percentage, you should apply the
"Percent Difference" quick table calculation to the Internet Usage field. This calculation compares
each value to the previous value and computes the difference as a percentage, which is ideal for
analyzing the rate of change over a sequential time period such as consecutive years.

NO.28 True or False: A reference line cannot be added from the Analytics Pane
A. True
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B. False
Answer: B
Explanation:
You can add a reference line to any continuous axis in the view.
To add a reference line:
Drag Reference Line from the Analytics pane into the view. Tableau shows the possible destinations.
The range of choices varies depending on the type of item and the current view.
In a simple case, the drop target area offers three options:

NO.29 What should you use to create headers in a visualization?
A. A parameter
B. A measure
C. A dimension
D A filter
Answer: C
Explanation:
According to the Tableau Help, headers are "labels that identify the different parts of your view". The
help also states that "Headers are created when you place a discrete dimension on Columns or Rows"
(page 1).

NO.30 What does the box in a box plot represent?
A. Maximum value of the data
B. Minimum value of the data
C. The interquartile range
D. The median of the middle half of the data points
Answer: C
Explanation:
In a box and whisker plot:
1) The ends of the box are the upper and lower quartiles, so the box spans the interquartile range
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2) The median is marked by a vertical line inside the box
3) The whiskers are the two lines outside the box that extend to the highest and lowest observations.

 

NO.31 What are two correct methods for creating a visual group? Choose two.
A. Select marks in the view.
B. Click the drop-down arrow from the top of the Data pane.
C. Right-click a dimension in the Data pane.
D. Drag a dimension onto another dimension in the Data pane.
Answer: C D
Explanation:
Two correct methods for creating a visual group are selecting marks in the view and right-clicking a
dimension in the Data pane. A visual group is a way of combining related members in a dimension
field to create categories or segments in your data. For example, you can create a visual group by
selecting several states in a map view and grouping them into regions. You can create a visual group
by selecting one or more marks in the view and then clicking the group icon on the tooltip or on the
toolbar. This will create a new group field in the Data pane with default names for each group based
on their members. You can also create a visual group by right-clicking a dimension in the Data pane
and selecting Create > Group. This will open the Create Group dialog box where you can select
several members and drag them into groups with custom names8 The other options are not correct
methods for creating a visual group. Clicking the drop-down arrow from the top of the Data pane will
open a menu with options for creating new fields, folders, sets, bins, etc., but not groups. Dragging a
dimension onto another dimension in the Data pane will create a hierarchy, which is a way of
organizing data into different levels of detail, not groups9

NO.32 True or False: It is possible to change the Geographic Role of a dimension
A. True
B. False
Answer: A
Explanation:
A geographic role associates each value in a field with a latitude and longitude value.
Assigning a geographic role based on the type of location (such as state versus postcode) helps
ensure that your data is plotted correctly on your map view. For example, you can assign the City
geographic role to a field that contains a list of city names.
To assign a geographic role to a field:
In the Data pane, click the data type icon next to the field, select Geographic Role, and then select the
geographic role you want to assign to the field.
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When you assign a geographic role to a field, Tableau adds two fields to the Measures area of the
Data pane:
Latitude (generated) and Longitude (generated).
These fields contain latitude and longitude values and are assigned the Latitude and Longitude
geographic roles. If you double-click each of these fields, Tableau adds them to the Columns and
Rows shelves and creates a map view using the Tableau background map.
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